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OVERVIEW
This manual covers the following topics related to your FLIR SyncroIP camera:

• Web browser configuration interface (page 2).

• Firmware update tool (page 38).

• PC CMS Software (page 41).

• Smartphone / tablet apps (page 56).

Notes
• For physical installation instructions, please refer to the Quick Connection Guide for your 

camera model.

• The following models have a different web interface and supporting software: DND13TL2, 
DNB14L2, DNB13TL2, DNV14TL2, DNE14TL2. For instructions, please refer to the respective 
manual for these cameras.
1



Web Configuration Interface
WEB CONFIGURATION INTERFACE
The camera includes a built-in web interface that can be accessed using a web browser.

Supported Browsers
• Google Chrome, Mozilla Firefox, and Apple Safari® (via Webplugin) 

• Microsoft Internet Explorer® 8.0 or later, 32-bit version (via ActiveX®)

Internet Explorer Setup
1. Open Internet Explorer and enter the camera’s IP address in the address bar in the following 

format: http://IP address:HTTP Port.
• For example: http://192.168.0.100:80

2. A notification bar appears asking if you would like to install ActiveX® plugins. Click Install or 
Allow to install the plugins.

Click Allow or Install

3. Enter the camera user name (default: admin) and password (default: admin) and click Login.

Enter user name (default: admin)
Enter password (default: admin)

Safari Setup
1. Open Safari® and enter the camera’s IP address in the address bar in the following format: 

http://IP address:HTTP Port.
• For example: http://192.168.0.100:80

2. Enter the camera user name (default: admin) and password (default: admin) and click Login.

Enter user name (default: admin)
Enter password (default: admin)
2



Web Configuration Interface
3. Click Please click here to download and install the plug-in.

4. Double-click webplugin.pkg in the downloads list to install. Follow the prompts to install.

Double-click to install the 
plugin

NOTE: If video from the camera does not appear after installation, quit Safari by right-clicking 
on the Safari icon in the dock and then selecting Quit. Then restart Safari and log back into your 
camera.

Live View
Upon login, the web interface opens to the Live View.

NOTE: Some functions are not available on all IP camera models, based on the features 
available.

1. Stream/Protocol Select: Allows you to select the video stream and protocol used in Live View.

• Main Stream: Click to view the Main Stream. The Main Stream provides better picture quality 
and resolution, but requires higher bandwidth.

1

2

3

4
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Web Configuration Interface
• Sub Stream: Click to view the Sub Stream. The Sub Stream is recommended for better 
performance when viewing the camera remotely.

• Protocol: Select the protocol that will be used to stream video: TCP or UDP.

NOTE: Multicast is not supported.

2. Video Display Controls 

•  Color Settings: Click to open color settings.

•  Original Size: Click to view the video in its original size. This depends on the resolution 
and if you are viewing the Main Stream or Sub Stream.

•  Full Screen: Click to view the video in full screen. Double-click or press ESC to exit full 
screen.

•  Width/Height Ratio: Click select Original to use the original proportions of the image or 
Adaptive to adapt the image proportions to the size of the screen.

•  Realtime/Fluency: Click to select Realtime, Normal, or Fluency.

•  PTZ Controls (PTZ cameras only): Click to hide/show PTZ camera controls. For details, 
see “PTZ Controls (PTZ Cameras Only)” on page 5.

3. Menu Tabs

• Live: Click to access Live View.

• Playback: Click to playback video from the camera’s microSD card (cameras that support 
microSD only).

• Setup: Click to setup camera functions.

• Alarm: Click to configure alarms.

• Logout: Log out of the camera.

4. Live View Functions

•  Alarm Output: Click to activate an alarm output device connected to the camera (cameras 
with alarm I/O only).

•  Digital Zoom: Click to activate digital zoom mode. Then, click-and-drag in the video area 
to select an area to zoom in. 

Brightness

Contrast

Hue

Saturation
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•  Snapshot: Click to save a snapshot from the camera to your computer hard drive. To 
configure the folder where snapshots are saved, see “Path” on page 14.

NOTE: Depending on your computer’s security settings, you may need to run your browser as 
administrator to save snapshots or manual recordings.

•  Triple Snapshot: Save the next three frames from the camera as snapshots.

•  Manual Record: Click to start manually recording live video to your computer hard drive. 
Click again to stop recording. To configure the folder where manual recordings are saved, see 
“Path” on page 14.

•  Manual Focus (motorized lens cameras only): Click to display the AF Peak and AF Max 
parameters for auto focus. The closer AF Peak and AF Max are, the better the focus effect is. 
To configure auto focus, see “Zoom and Focus (Motorized Lens Cameras Only)” on page 11.

•  Audio Output: Click to mute/un-mute audio coming from the camera (audio-enabled 
cameras only; must have self-powered microphone connected to the camera).

•  Intercom: Click to activate the intercom to the camera (audio-enabled cameras only; must 
have amplifier or speakers connected to the camera.

•  Help: Click to access the built-in help file.

PTZ Controls (PTZ Cameras Only)
From Live View, click  to open the PTZ control panel.

PTZ Control Panel

Click the arrows to move 
the camera

Click middle button and 
then click and drag on the 
video to move the camera

Adjust the camera speed

Adjust the zoom

Adjust the focus

Adjust the iris

Scan
You can use the Scan function to have the camera move automatically between two points.

To configure scan function:
5
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1.

Set up Scan

Save right positionSave left position

Start Scan

Select Scan

Select Scan under PTZ Settings.

2. Click Set.
3. Move the camera into the desired left position and then click Set Left to save.
4. Move the camera into the desired right position and then click Set Right to save.
5. Click Save.
6. Click Start to start the Scan.

Preset
You can save preset positions in the camera to recall them later.

To save presets:
1. Select Preset under PTZ Settings.

Select Preset

Enter the preset number

Go to preset

Save preset

Delete preset

2. Enter the number of the preset you would like to save.
3. Move the camera into the desired position.
4. Click Add to save the preset.
To go to a preset:
1. Enter the number of the preset you would like to go to.
2. Click Goto.
To delete presets:
6
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1. Enter the number of the preset you would like to save. 
2. Click Del.

Pattern
You can use the pattern function to record a series of camera movements to recall later.

To save a pattern:
1. Select Pattern under PTZ settings.

Select Pattern

Enter pattern number

Start/stop pattern

Start recording pattern

Delete pattern
Configure pattern
Stop recording pattern

2. Enter the number of the pattern you would like to save.
3. Click Add.
4. Click Start Rec. Use the PTZ controls to save a series of movements.
5. When you finish recording the pattern, click Stop Rec.

To run a pattern:

• Click Start.
7
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Goto
The Goto function allows you to move the camera to a position with specified parameters.

To move the camera to a specified position:
1. Select Goto under PTZ settings.
2. Enter the Horizontal Angle you would like to move the camera to between 0~3550.
3. Enter the Vertical Angle you would like to move the camera to between 0~900.
4. Enter the Zoom level between 1~128.
5. Click Goto to go to the specified position.

Select Goto

Set horizontal angle

Set vertical angle

Set zoom level

Click to goto position
8
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Setup
The Setup menus allow you to configure camera settings.

Camera

Conditions
The Conditions menu allows you to configure the image sensor settings for the camera. As you 
make adjustments, the effects will be shown in the video display.

NOTE: Some settings described below may not be available, depending on the features of your 
camera model.

To configure the image sensor settings:
1. Configure the following:

• Profile: Select the camera settings profile you would like to configure: Day, Night, or Normal.

• Brightness: Adjust the brightness of the image between 0 and 100. 

• Contrast: Adjust the contrast of the image between 0 and 100.

• Saturation: Adjust the color saturation of the image between 0 and 100.

• Sharpness: Adjust the sharpness of the image between 0 and 100. Higher sharpness will 
make edges in the image clearer, but may increase noise in the picture.

• Anti-flicker: Select the anti-flicker mode depending on the environment:

• Outdoor: The system will use the exposure mode to adjust for lighting.
• 50Hz: The system will compensate for lighting using 50Hz AC power (i.e. for Europe).
• 60Hz: The system will compensate for lighting using 60Hz AC power (i.e. for North 

America).

• Exposure: Select the exposure mode. 

• Auto: The system will automatically adjust the brightness and exposure based on the 
environment. 

• Low Noise: The system will automatically adjust the gain to reduce the amount of noise 
in the image. Set the minimum and maximum Gain Scope. Increasing the max gain will 
increase the noise reduction.
9
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• Low Motion Blur: The system will automatically adjust the shutter to reduce motion 
trails in the image. Set the minimum and maximum Shutter Scope.

• Manual: Configure manual exposure settings. Configure the Shutter Regulate and Gain 
Scope.

• Profile: Select the white balance mode.

• Auto: Automatic white balance.
• Sunny: White balance mode for daylight.
• Night: White balance mode for night time.
• Customized: Manual white balance. Use the sliders to configure the Red Control and 

Blue Control.

• Auto Iris (auto iris cameras only): Select ON to enable auto iris or OFF to disable auto iris.

• Day & Night: Select one of the following day / night modes.

• Color: Camera will be in day mode at all times.
• Auto: Camera will automatically change between day and night mode based on the 

lighting.
• B/W: Camera will be in black and white at all times.

• BLC Mode: Select one of the following modes:

• BLC (Backlight Compensation): The camera automatically adjusts the exposure for a 
clearer image in the darkest areas of the video. Click Default to use default settings or 
Customized to adjust the BLC area. The darker the area you select, the brighter the 
image will be.

• WDR (Wide Dynamic Range): The camera compensates for changes in brightness across 
the image to enhance the picture quality of both light and dark areas. Adjust the WDR 
level between 1 and 100.

• HLC (Highlight Compensation): The camera dims the brightest areas of the image to 
make them clearer. Adjust the HLC level between 1 and 100.

• Off: Disable this function.

• Mirror: Select ON to flip the camera left and right.

• Flip: Select one of the options to flip the image or No Flip to disable. Note that 90° rotations 
are not supported if the Main Stream is set above 720p resolution.

2. Click Save to save changes. Click Cancel to return to last saved configuration. Click Default 
to return to factory defaults.

Profile Management
The Profile Management tab allows you to set which Condition Profile to use at what times.

To configure the condition profile:
1. Select one of the following options:
10
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• Normal: Camera will use the Normal profile at all times.

• Full Time: Select the profile the camera will use at all times.

• Schedule: Configure a schedule that the camera will use for Day (yellow) and Night (black) 
profiles. Click and drag in the time bar to set the schedule.

2. Click Save to save changes.

Zoom and Focus (Motorized Lens Cameras Only)
For motorized lens cameras, you can use the Zoom and Focus tab to adjust the lens.

• Zoom: Click +/- or use the slider to adjust the zoom level.

• Focus: Click +/- or use the slider to adjust the focus.

• Auto Focus: Click to have the camera automatically adjust the focus to the currently selected 
zoom level.

NOTE: Adjustments in this menu are automatically saved.
11
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Video
The Video menu allows you to configure the encoding settings for the camera. Video settings are 
divided into Main Stream and Sub Stream.

To configure video quality settings:
1. Check Enable under Sub Stream to enable the sub stream or uncheck to disable.
2. For the Main Stream and Sub Stream, configure the following:

• Code Stream Type: For the Main Stream, select General to configure settings when motion 
is not detected or Motion to configure settings when motion is detected.

• Encode Mode: Select the encoding type: H.264 (Main H.264 profile), H.264H (High Profile 
H.264), H.264B (Baseline H.264 profile), MJPEG. 

NOTE: A much higher bitrate and faster connection is required to maintain image quality using 
MJPEG. It is recommended to use H.264 unless you have special requirements.

• Resolution: Select the desired resolution for the video stream. There is a different 
recommended bit rate depending on the resolution selected.

NOTE: You may not set the resolution above 720p if the Flip function is activated.

• Frame Rate (FPS): Select the desired frame rate for the video stream between 1 and 30 FPS.

• Bit Rate Type: Select CBR (Constant Bit Rate) or VBR (Variable Bit Rate). If you select VBR, 
you can select the Video Quality between 1 (lowest) and 6 (best).

• Reference Bit Rate: Recommended bit rate range based on the resolution and frame rate 
settings you have selected.

• Bit Rate: Select the desired bit rate for each video stream or select Customized and enter the 
bit rate in Kbps.

• I Frame: Select the interval for I frames. It is recommended to select 2 unless you have special 
requirements.

3. Under Watermark Settings, check to enable watermark to protect against video tampering.
4. Under Watermark Character, enter the desired watermark text.
5. Click Save to save changes.
12
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Snapshot
The Snapshot menu allows you to configure images quality settings for snapshots.

To configure snapshots:
1. Configure the following:

• Snapshot Type: Select General to configure snapshots taken using scheduled recording. Select 
Event to configure snapshots activated by alarms.

• Image Size: The image size of snapshots is the same as the resolution for the stream selected.

• Quality: Select the image quality for snapshots between 1 (lowest) and 6 (highest).

• Snapshot Stream: Select Main Stream to take snapshots from the Main Stream or Sub Stream 
to take snapshots from the Sub Stream.

• Interval: Select the interval between snapshots between 1 and 7 seconds.

2. Click Save to save changes.

Overlay
The Overlay tab allows you to configure the OSD text on the camera video display.

To configure the OSD:
1. Check Privacy Masking to enable privacy masking. Then, click Setup to configure privacy 

areas. You may have up to 4 privacy areas.

• Click the corners of a privacy area to adjust the size of the privacy area.

• Right-click to delete the currently selected privacy area.

• Click and drag outside of the privacy areas to create a new privacy area.

• Click Save to save changes.

2. Under Channel Title, check to show the channel title. Click Setup to enter a custom channel 
title.

3. Under Time Title, check to show the time. Click Setup and then check Week Display to show 
the day of the week.
13
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4. Under Location, check to add a custom message, and then click Setup to enter a custom 
message up to 5 lines.

5. Click Save to save changes.

Path
The Path tab allows you to configure the folder where snapshots and manual recordings are 
saved.

To configure the recording and snapshot folder:
1. Configure the following:

• Snapshot Path: The folder on your hard drive where snapshots are stored. Click Browse to 
select a different folder.

• Record Path: The folder on your hard drive where manual recordings are stored. Click Browse 
to select a different folder.

2. Click Save to save changes.

Network

TCP-IP
The TCP-IP menu allows you to configure the camera for DHCP or Static IP addressing.

To configure IP address settings:

1. Under Host Name, enter the Host Name for the camera up to 32 characters.
2. Under IP Version, select IPV4 or IPV6.
14
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3. Under Mode, select Static or DHCP. If you select Static, configure the IP Address, Subnet 
Mask, Default Gateway, Preferred DNS Server, and Alternate DNS Server.

4. Click Save to save changes.

Connection
The Connection menu allows you to configure the camera ports and maximum connections to the 
camera. You must port forward the HTTP (default: 80) and TCP (default: 35000) port numbers on 
your router to enable remote connection to your camera

NOTE: If you are not using an  and are setting up multiple cameras in the same network for 
remote access, you must assign unique TCP and HTTP ports for each camera. Two cameras 
cannot share the same port number.

To configure connection settings and ports:
1. Under Max Connection, enter the maximum number of devices that can connect to the 

camera at the same time between 1 and 20.
2. Configure the following port settings:

• TCP Port: Enter the TCP (Client) Port number (default: 35000). The TCP port is used to stream 
video to remote computers or mobile devices. The TCP Port must be port forwarded to enable 
remote connection to your camera. 

• UDP Port: Enter the UDP Port number (default: 37778). The UDP Port is used for special 
applications only.

• HTTP Port: Enter the HTTP Port (default: 80). The HTTP Port is used to access the camera’s 
web interface. The HTTP Port must be port forwarded to enable remote access.

NOTE: If you change the HTTP Port to anything other than 80, you must enter colon (:) and the 
HTTP port in your web browser to access the camera (e.g. http://tomsmith.myddns-flir.com:85).

• RTSP Port: Enter the RTSP Port (default: 554). The RTSP Port is used for special applications.

3. (Optional) To enable HTTPS, check HTTPs On. To connect to the camera using HTTPS, you 
must forward the HTTPS port (default: 443) on your router. You must also connect to the 
camera using the following format:

• https://IP or DDNS address:HTTPS Port

• For example: https://tomsmith.myddns-flir.com:443
15
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4. (Optional) To configure the HTTPS port, enter the custom port number under HTTPS Port 
(default: 443).

5. Click Save to save changes.

PPPoE (Unsupported)

DDNS
The DDNS menu allows you to set up the camera with a free FLIR DDNS account for remote 
connectivity. You can register for a FLIR DDNS account at ddns.myddns-flir.com.

To configure DDNS:
1. Under Server Type, check the checkbox and select FlirDDNS.
2. Under Domain Name, enter the Domain Name from the confirmation email you received after 

registering for DDNS.
3. Under Username, enter the User Name from the confirmation email.
4. Under Password, enter the Password from the confirmation email.
5. Click Save.

NOTE: It may take between 10~15 minutes for the DDNS server to update with your new DDNS 
address.

IP Filter
The IP Filter allows you to create a white list of device MAC or IP addresses that can access the 
camera. If you use the IP filter menu, devices that are not on the white list will not be able to 
16
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remotely connect to the camera.

To filter connections based on IP or MAC addresses:
1. Click Add IP/MAC.
2. Select IP Address or MAC Address and then enter the address of the device you would like to 

add to the white list.
3. Click Save.
4. Check Trusted Sites.
5. Click Save to save changes.

SMTP (Email)
The SMTP menu allows you to set up email alerts for motion or alarms.

To configure SMTP Settings: 
1. Under SMTP Server, enter the SMTP server address.

If you enable the IP filter the camera will block any device that is not listed. Make 
sure the correct devices are added to the list, or you may not be able to access the 
camera.
17
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2. Under Port, enter the Port used by the server.
3. Check Anonymity if the server allows anonymous logins or uncheck to enter credentials to 

access the server.
4. Under Username, enter the user name of the sender’s account.
5. Under Password, enter the password of the sender’s account.
6. Under Sender, enter the sender’s email account.
7. If the server uses encryption, select SSL or TLS under Authentication.
8. Under Interval, select the interval for sending email alerts. The system will only send email 

alerts after this interval has passed.
9. Check Health Mail to enable the camera to send health alerts. If you enable health alerts, 

enter the interval in seconds under Update Period.
10. Click Email Test to send a test email using the settings you have entered.
11. Click Save to save changes.

UPnP
UPnP allows you to map port numbers between the LAN and the Internet. Depending on your 
router version, you may need to disable UPnP function.

Bonjour

The Bonjour menu allows you to enable the Bonjour service to easily detect the camera on a local 
network when using a Mac.

To enable / disable the Bonjour service:
1. Check Enable to enable Bonjour or uncheck to disable.
2. Under Server Name, enter the name of the camera that will show up when accessing the 

camera through Bonjour in Safari.
3. Click Save to save changes.
18
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To access the camera through Bonjour:

1. In Safari, click  to open the Bookmarks menu.
2. Click Bonjour, the IP Camera will appear in the list.

Click 
Bonjour

Double-click 
the camera

3. Double-click the IP camera to open it in a browser tab.

SNMP (Unsupported)

Multicast (Unsupported)

IEEE802 (Unsupported)

QOS (Unsupported)

Event

Video Detect
The Video Detect menu allows you to set up motion detection and recording.

NOTE: Recording functions require an FTP server or microSD card. Some camera models do 
not support microSD recording.

To set up motion detection settings:
19
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1. Check Enable to enable motion detection.
2. To configure a schedule when motion detection will be activated, click Setup next to Working 

Period.

Click Setup to select the day 
to configure

Click the checkboxes to 
apply the same schedule to 
multiple daysConfigure up 

to 6 time 
periods

 

• Select the day you would like to configure by clicking the Setup buttons. You can apply the 
same schedule to multiple days using the checkboxes.

• Configure up to 6 time periods when motion detection will be activated.

• Click Save. Repeat the steps above if you would like to apply a different schedule to different 
days.

3. Under Anti-dither, enter the anti-dither time. After a motion event occurs and motion stops, 
if motion is detected within the anti-dither time, the system continues the motion event and 
includes the new motion within the first event, rather than creating a new motion event.

4. To configure the motion grid, click Setup next to Area.

• Areas where motion detection is enable are represented by yellow boxes. 

• To resize an area, click on one of the corners and drag. 

• To move an area, click inside and drag.

• Right-click to delete the selected area.

• Click and drag outside of all areas to draw a new area. You may have up to 4 motion areas.

• Use the sliders to adjust the Sensitivity and Threshold for motion detection. 

• The Sensitivity determines how sensitive the camera is to motion. For example, if the 
sensitivity is high, small amounts of motion will score higher on the graph. It is 
recommended to select a Sensitivity between 30~70.

• The Threshold determines how much motion is required to trigger an alarm or recording. 
It is represented by the horizontal line on the graph. If the amount of motion in the area 
exceeds this line, it will trigger an alert. It is recommended to select a Threshold between 
10~50.

• Each motion area can have a separate Sensitivity and Threshold value.
20
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• Click Save.

5. Check Record to record when motion is detected. microSD or FTP recording must be 
configured to use this function.

6. Enter number of seconds the camera will record after motion is detected under Record Delay.
7. Check Relay Out to trigger an external alarm device when the camera detects motion. The 

camera must have an Alarm Output to use this function.
8. Enter the number of seconds the camera will trigger the external device under Alarm Delay.
9. Check Send Email for the camera to send an email alert when motion is detected. Email 

settings must be configured to receive email alerts.
10. Check Snapshot for the camera to save a snapshot when motion is detected. microSD or FTP 

recording must be configured to use this function.
11. Click Save to save changes.

Video Masking (Unsupported)

Alarm (Cameras with Alarm I/O Only)
The Alarm menu allows you to configure settings for alarm devices. Your camera must have an 
alarm I/O connector to use alarm devices.

To configure alarm device settings:

Threshold

Amount of motion detected
21
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1. Configure the following:

• Under Relay-In, select the alarm device you would like to configure.

• Check Enable to enable the selected alarm In device.

• Click Setup next to Working Period to set a schedule for alarm device activation.

• Under Anti-Dither, enter the latch time in seconds.

• Under Sensor Type, select NO (Normally Open) or NC (Normally Closed) depending on the 
type of sensor used.

• Check Record to record when a sensor device is triggered. 

• Under Record Delay, enter the amount of time the system will record when a sensor device 
is triggered.

• Check Relay-out to activate an alarm output device (e.g. strobe light) when the sensor device 
is triggered. The camera must have an alarm output to use this feature. 

• Check Send Email for the camera to send out an alert email when the sensor device is triggered.

• Check Snapshot for the camera to save a snapshot to FTP or microSD when the sensor device 
is triggered.

2. Click Save to save changes.

Warning
The Warning menu allows you to configure system warnings. The following system warning types 
are supported: No SD Card, SD card Capacity Warning, SD Card Error, Disconnection, and IP 
Conflict.

NOTE: No SD Card, Capacity Warning, and SD Card Error are only available on cameras that 
support microSD.

No SD Card
A No SD Card error occurs if recording is set in the camera, but there is no microSD or SD card 
installed.

To configure No SD Card errors:
1. Check Enable to enable No SD Card errors.
2. Check Relay-out to trigger an alarm out device when No SD Card errors occur. Under Alarm 

Delay, enter the number of seconds the alarm out device will be activated.

NOTE: Relay-out is only available if your camera supports alarm output.
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3. Check Send Email to send an email alert when No SD Card errors occur.

Capacity Warning
A Capacity Warning occurs when the recording destination (microSD or SD card or FTP server) 
reaches capacity.

To configure Capacity Warnings:
1. Check Enable to enable Capacity Warnings.
2. Under Capacity Limit, set the percentage of free space on the recording destination that will 

trigger a Capacity Warning. For example, if you enter 10% and your microSD card is 1GB, a 
warning will occur when there is only 100MB of free space remaining.

3. Check Relay-out to trigger an alarm out device when Capacity Warnings occur. Under Alarm 
Delay, enter the number of seconds the alarm out device will be activated.

NOTE: Relay-out is only available if your camera supports alarm output.

4. Check Send Email to send an email alert when Capacity Warnings occur.
5. Click Save to save changes.

SD Card Error
An SD Card Error occurs if an error occurs recording to the microSD or SD card (for example if 
the SD card is damaged or is using the wrong file system).

To configure SD Card Errors:
1. Check Enable to enable SD Card Errors.
2. Check Relay-out to trigger an alarm out device when SD Card Errors occur. Under Alarm 

Delay, enter the number of seconds the alarm out device will be activated.

NOTE: Relay-out is only available if your camera supports alarm output.

3. Check Send Email to send an email alert when SD Card Errors occur.
4. Click Save to save changes.
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Disconnection
A Disconnection error occurs if the camera is disconnected from the network.

To configure Disconnection Errors: 
1. Check Enable to enable Disconnection errors.
2. Check Record to record to the microSD or SD card when Disconnection errors occur.

NOTE: The camera must support microSD or SD card recording to use this function.

3. Under Record Delay, enter the number of seconds the camera will record after a 
Disconnection error.

4. Check Relay-out to trigger an alarm out device when Disconnection errors occur. Under 
Alarm Delay, enter the number of seconds the alarm out device will be activated.

NOTE: Relay-out is only available if your camera supports alarm output.

5. Check Send Email to send an email alert when Disconnection errors occur.
6. Click Save to save changes.

IP Conflict
An IP Conflict error occurs if another device is assigned the same IP address as the IP camera.

To configure IP Conflict errors:
1. Check Enable to enable IP Conflict errors.
2. Check Record to record to the microSD or SD card when IP Conflict errors occur.

NOTE: The camera must support microSD or SD card recording to use this function.

3. Under Record Delay, enter the number of seconds the camera will record after an IP Conflict 
error.

4. Check Relay-out to trigger an alarm out device when IP Conflict errors occur. Under Alarm 
Delay, enter the number of seconds the alarm out device will be activated.

NOTE: Relay-out is only available if your camera supports alarm output.

5. Check Send Email to send an email alert when IP Conflict errors occur.
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6. Click Save to save changes.

Storage
The Storage menu allows you to configure recording settings.

Record Schedule
The Record Schedule determines the schedule for video recording to SD card or FTP.

To configure the recording schedule:
1. Click Setup next to the day you would like to configure.
2. Use the checkboxes if you want to copy the schedule to other days.
3. Configure up to 6 time periods for recording. For each period, enter a time range and check 

the recording types you would like to enable during that period:

• General: Continuous recording.

• Motion: Motion activated recording.

• Alarm: Alarm activated recording.

4. Click Save.

Snapshot Schedule
The Snapshot schedule determines the schedule for snapshot recording.

Check to copy 
schedule Enable recording types

Configure up 
to 6 periods
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To configure the snapshot schedule:
1. Click Setup next to the day you would like to configure.
2. Use the checkboxes if you want to copy the schedule to other days.
3. Configure up to 6 time periods for recording. For each period, enter a time range and check 

the recording types you would like to enable during that period:

• General: Continuous recording.

• Motion: Motion activated recording.

• Alarm: Alarm activated recording.

4. Click Save.

Holiday Schedule
The Holiday Schedule allows you to set certain days of the year as holidays.

To configure the holiday schedule:
1. Check Record or Snapshot to enable holidays for that recording type.
2. Use the calendar to select which days are holidays.
3. Click Save.

Destination - Path
The Path tab allows you to select if the camera records to microSD or FTP.

To select the recording destination:

Check to copy 
schedule Enable recording types

Configure up 
to 6 periods
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1. Under Record or Snapshot, check Local to record to the microSD card or FTP to record to 
FTP. For video recording or snapshot recording, you cannot record to both microSD and FTP.

2. Click Save.

Destination - Local
The Local tab allows you to format or configure the microSD card installed in the camera.

• Click Read Only to set the microSD card on read only mode. This disables microSD recording.

• Click Read & Write to enable recording on the microSD card.

• Click Hot Swap to unmount the microSD card if you would like to eject it from the camera.

• Click Format and then click Yes to format the microSD card. The camera will reboot once the 
format is completed.

Destination - FTP
The FTP tab allows you to set up settings for recording to an FTP server.

To set up FTP settings:
1. Check Enable to enable recording to FTP.
2. Configure the following:

• Server Address: Enter the IP address or DNS address of the FTP server.

• Port: Enter the FTP server port number.

• User Name: Enter the user name for the FTP server.

• Password: Enter the password for the FTP server.

• Remote directory: Enter the recording directory on the FTP server (e.g. share).

NOTE: The recording directory must be located one level below the root directory. For example 
share is acceptable, but not share/.

• Check Emergency (Local) to enable microSD recording if the FTP server cannot be reached.
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3. Click Save to save changes.

Record Control
The Record Control menu allows you to configure recording parameters for the camera.

To configure recording parameters:
1. Under Pack Duration, enter the duration in minutes that the camera will use to pack video 

files.
2. Under Pre-event Record, enter the duration in seconds that the camera will pre-record 

before motion events.
3. Under Disk Full, select Overwrite to overwrite recordings when the recording medium is full 

or select Stop to stop recording when the recording medium is full. 

• Under Record Mode, select Auto to record according to the schedule, select Manual to record 
continuously, or select Off to disable recording.

4. Under Record Stream, select Main Stream to record using the Main Stream settings, or 
select Substream to record the substream.

5. Click Save to save changes.

System

General
The General menu allows you to configure general camera settings.

To configure general camera settings:
1. Under Device Name, enter a name for the camera.
2. Under Language, select the language that will be used for the web browser interface.
3. Under Video Standard, select NTSC (North America) or PAL (Europe).
4. Click Save.
28



Web Configuration Interface
General - Date & Time
The Date & Time tab allows you to set up date and time settings for the IP camera.

To configure date & time settings:
1. Configure the following: 

• Date Format: Select the date format.

• Time Format: Select the time format (12 hour or 24 hour).

• Time Zone: Select your time zone.

• Current Time: Enter the current time or click Sync PC to sync your IP camera to your PC’s clock.

2. If your area uses Daylight Savings Time (DST) check DST Enable. If you enable DST, configure 
the following:

• DST Type: Select Date to select a date for the time change or select Week to select the week 
and day for the time change.

• Start Time and End Time: Enter the start and end times for Daylight Savings.

3. Check Synchronize with NTP to synchronize the camera clock with an NTP time server. A 
constant Internet connection is required to use NTP. If you enable NTP, configure the 
following:

• NTP Server: Enter the NTP server address.

• Port: Enter the port for the NTP server.

• Update Period: enter the interval the camera will use to update the time.

4. Click Save.

Account
The Account menu allows you to configure user accounts and user groups. The camera can 
support up to 18 user accounts and up to 8 groups. User accounts must be assigned to a group 
and inherit permissions from user groups, but an individual user account can be given less 
permissions than the group.

The camera includes a unique admin account that cannot be deleted. The admin account is the 
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only one that can change permissions assigned to user accounts. Accounts given permission to 
access the Account menu may change the password for other accounts. Accounts not given 
permission to access the Account menu may not change any account passwords, including their 
own. It is essential to change the password of the admin account from the default to prevent 
unauthorized access to your camera.

You may also check Anonymous Login to allow users to connect to the camera without entering 
a user name or password. Users connecting anonymously are given limited access to the camera: 
they may only view live video and the Alarm list.

To create a user account:
1. Click Add User.
2. Configure the following:

• User Name: Enter a user name for the user. The user name can be up to 15 characters including 
letters, numbers, and underscores.

• Password: Enter a password for the user account.

• Group: Assign the user account to a group. The user account will inherit permissions from 
the group, which will be updated under Authority List.

• Remark: (Optional) Enter a description for the user account.

• Authority List: Use the checkboxes to assign permissions to the user account.

3. Click Save.

To create a user group:
1. Click the Group tab.
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2. Click Add Group.

3. Configure the following:

• Group: Enter a name for the group.

• Remark: (Optional) Enter a description for the group.

• Authority List: Use the checkboxes to assign the default permissions for user accounts added 
to this group.

4. Click Save.

To modify a user account or group:
1. Select the User or Group tab.

2. Click  next to the account or group you would like to delete.

Click to modify an 
account or group

3. Edit the account or group details and then click Save.

To delete a user account or group:
1. Select the User or Group tab.
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2. Click  next to the account or group you would like to delete.

Click to delete an 
account or group

3. Click OK.

Default
Click the Default button and then click OK to reset the camera to default settings. The camera will 
reboot.

Import/Export
The Import/Export menu allows you to export your camera’s configuration or import a saved 
configuration.

To export the camera’s configuration:
1. Click Export. 
2. Select a location on your computer and then click Save.

To import the camera’s configuration:
1. Click Import.
2. Select the configuration file you would like to backup and then click Open.
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Auto Maintain
The Auto Maintain menu allows you to reboot the camera manually or on a automatic schedule. 
Rebooting the camera regularly ensures system stability. It also allows you to automatically 
delete old video files.

To manually reboot the camera:

• Click Manual Reboot and then click OK to reboot the camera.

To configure auto reboot:
1. Check Auto Reboot to set the camera to reboot automatically on schedule.
2. Select the day and time for the camera to reboot.
3. Click Save.

To configure auto delete:
1. Check Auto Delete Old Files.
2. Enter the number of days the camera will retain video files.
3. Click Save.

Upgrade
The Upgrade menu allows you to upgrade the camera firmware. When firmware upgrades are 
released, they are available for free from www.digimerge.com.

To upgrade the camera firmware:
1. Download and extract the firmware from www.digimerge.com.
2. Click Browse.
3. Select the firmware file on your computer and then click Open.
4. Click Upgrade. The camera will upgrade the firmware and then reboot.
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Information

Version
The Version menu shows you information related to the product and firmware version.

Log
The Log menu allows you to view system logs for the camera.

To view system logs:
1. Under Start Time and End Time, enter the start time and end time for your search.
2. Under Type, select the type of log you would like to search for: All, Setting, Data, Event, 

Record, Account, and Clear Log.
3. Click Search.

• (Optional) Click Backup to save logs to your computer hard drive.

• (Optional) Click Clear to delete all system logs.
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Playback (Cameras with microSD Only)
Playback mode allows you to playback video from the camera’s microSD card.

To playback video from the microSD card:
1. Use the calendar to select a day to search for video. The bar on the bottom populates with 

video recorded on that day.
2. Click in the time bar to start playback.

Click to select 
a day

Click to select 
a time

OR

1. Click in the calendar to select a day to search for video.

2. Click . A list appears with video files from the selected day.
3. Click a time to select it.

Click to select a time

4. Click  then  to start playback.
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Playback Controls

Backing up Video Files
You can download video files to your computer hard drive. Video files are saved in (.dav) format. 
You can use the video player available from www.digimerge.com to play backup video files.

To backup video files:
1. Click in the calendar to select a day to search for video.

2. Click . A list appears with video files from the selected day.

Play

Stop

Next 
frame

Slow

Fast

Mute

Volume
Zoom into 
time bar

Show/hide recording 
type in time bar

Select playback time
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3. Click  next to the video file you would like to download to your computer hard drive.

Click to select a time
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Upgrade Tool
UPGRADE TOOL
To perform a firmware upgrade over the LAN or Internet, a Config Tool is provided on the CD or 
www.digimerge.com. In an effort to continuously improve the functionality of our products, 
firmware upgrades are available as a free download on www.digimerge.com.

NOTE: The Config Tool is supported on PC only. Firmware upgrades can also be completed 
using the web browser interface (see “Upgrade” on page 33).

Installing a Firmware Upgrade Over the LAN
Prerequisites:

• Connect your IP camera to a router or switch on your network.

• Download a firmware upgrade from www.digimerge.com, if one is available. Extract the 
contents.

To perform a firmware upgrade over the LAN:
1. Download the Config Tool from www.digimerge.com.
2. Extract the contents into a folder.
3. Open the folder and right-click ConfigTool.exe and Run as administrator. If a Windows 

Firewall warning appears, click Allow Access. The Config Tool scans your LAN for IP 
cameras.

4. Click Upgrade.

Click Upgrade

5. Check any IP cameras you would like to upgrade.
6. Click Open. Select the upgrade firmware file (.bin).
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7. Click Upgrade. Wait for the upgrade to complete. Do not power off the system or disconnect 
the power cable during upgrade. The system will restart when the upgrade is complete.

Check ’s

Click Open and select firmware file

Click Upgrade

Installing a Firmware Upgrade Over the Internet
Prerequisites:

• Port forward the Client Port (default: 35000) on the IP camera’s local router.

• Obtain the public IP address of the IP camera.

• Download a firmware upgrade from www.digimerge.com, if one is available. Extract the 
contents.

To perform a firmware upgrade over the Internet:
1. Download the Config Tool from www.digimerge.com.
2. Extract the contents into a folder. 
3. Open the folder and right-click ConfigTool.exe and Run as administrator.
4. Click Login.
5. Under IP Address, enter the public IP address of the IP camera. Edit the User Name, 

Password, or Port if these have been changed from the default values. 

Enter the IP camera’s 
public IP address

6. Click Login. The Config Tool logs in to the IP camera.
7. Click System Upgrade.
8. Click Open. select the firmware file (.bin).
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9. Click Upgrade. Wait for the upgrade to complete. Do not power off the system or disconnect 
the power cable during upgrade. The system will restart when the upgrade is complete.

Click System Upgrade

Click Open and select the firmware file
Click Upgrade and select the firmware file
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FLIR SYNCROIP  CENTRAL MANAGEMENT 
SOFTWARE FOR PC
FLIR SyncroIP  CMS is a central management software that allows you to view and manage 
multiple s and IP cameras.

System Requirements
Your system must meet or exceed the system requirements below:

NOTE: To connect to your system on Mac, please visit www.digimerge.com for instructions.

Description Requirement

CPU Core 2 Duo 3.0GHz 

Operating System Windows™ 8/7/Vista

Memory 2GB

Video 512 MB of video memory and above

Network (LAN) 10/100 BaseT Network

Network (WAN) 1 Mbps upstream

*High-speed Internet service is required to remotely connect to your system.
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Installing FLIR SyncroIP  CMS
Install FLIR SyncroIP  CMS from the CD included with your IP camera or by downloading it from 
www.digimerge.com. It is recommended to visit www.digimerge.com for the latest software 
versions.

To start the software:

• Double-click the FLIR SyncroIP  CMS icon ( ) on the desktop.

• Click Login.

NOTE: The CMS default User Name is admin and the Password is admin.

Adding an IP camera from the Local Area Network (LAN)
Once you open the software, you can add an IP camera.

Prerequisites:

• Connect the IP camera to a router or switch on the network.

• Install the CMS on a computer in the same LAN as the IP camera.

Login
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To add a :
1. Click Config Manager>Device Manage.

Click Config Manager

Click Device Manage

2. Click Search Device. If a Windows Firewall alert appears, click Allow.
3. Check the IP camera and click Add Management.

Click Add Management

Click Search Device

Check the 

4. Enter the User Name (default: admin) and Password (default: admin) for the IP camera and 
click OK.

Enter User Name 
(default: admin)

Enter Password 
(default: 000000)

5. Click OK.
6. Click Device List.
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7. Click + next to No Group.
8. Double-click the IP camera.
9. Click-and-drag the IP camera to the display area to view.

Click Device List
Click +
Double-click the 

Click-and-drag the  to the 
display area to view

Adding an IP camera using a DDNS address
If you have IP camera systems with DDNS set up, you can add them to the CMS.

Prerequisites:

• Create a DDNS account. For details, see the Quick Network Guide provided with your camera 
or see “DDNS” on page 16.

• Enter the DDNS information into the IP camera locally.

• Port forward the Client and HTTP ports (default, ports 80 and 35000) on the router.

To add an IP camera using a DDNS address:
1. Click Config Manager>Device Manage.

Click Config Manager

Click Device Manage
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2. Click Manual Add.

Click Manual Add

3. Configure the following:

• Title: Enter a name for your IP camera of your choice (e.g. home or office).

• Type: Select IP Camera.

• Add Type: Select Single Device.

• Domain Name: Enter the Domain Name from the confirmation email after your registered for 
DDNS, followed by .myddns-flir.com.

• Port: Enter the Client Port (default: 35000).

• User: Enter the IP camera’s user name (default: admin).

• Password: Enter the IP camera’s password (default: admin).

4. Click Add, then click OK.
5. Click Device List.
6. Click + next to No Group.
7. Double-click the IP camera.

Enter name of your choice

Select 

Select Domain name
Enter Domain Name, followed by .myddns-flir.com

Enter TCP Port (default: 35000).

Enter User Name (default: admin).

Enter Password (default: admin).

tomsmith.myddns-flir.com
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8. Click-and-drag the IP camera to the display area to view.

Click Device List
Click +
Double-click the 

Click-and-drag the  to the 
display area to view

CMS Live Viewing Overview

1. Camera Controls:

Digital Zoom 
(Click and drag)

Change 
display mode

Manual 
record

Snapshot

Disconnect

1

2

3

5
4

6
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2. Live View Toolbar:

Select image 
quality

Latency/
Fluency

Full-screen

Display views

3. CMS Quick Menus: Click to access key CMS functions.
4. CMS Window Controls:

Lock CMS Full Menu

Minimize

Maximize/
Restore

Quit

5. Device List: Open ’s and IP cameras in live display.

• Click + next to ’s, Groups, or IP cameras to expand.

• Click and drag ’s, Groups, or IP cameras to the display area to open.

• Right-click ’s, Groups, or IP cameras to view system options.

6. CMS Menus:

• PTZ Direction: Access basic PTZ controls.

• PTZ Advanced: Access advanced PTZ controls (e.g. Auto Scan, Tour, etc.).

• Tools: Contains the following menus: Begin Record Plan, NVD Control, 
Health Report, Log Search, Alarm Video, Alarm Output, Color Config, 
Volume.

• Config Manager: Contains the following menus: Scheme Task Config, 
Record Plan Config, Alarm Config, Alarm Rec Config, E-Map Config, 
DecCard Config, User Manage, Device Manage, Ext Screen Manage, User 
Config.

Configuring Projects
Once you have multiple tasks set up, you can configure projects to automatically cycle through 
them.

To configure a project: 
1. Click Config Manager>Scheme Task Config.
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2. Click Monitor Project.

Click Monitor Project

3. Click New.
4. Enter a Name for the project. You may not change the name after the project is created.
5. Under Mode, select Tour Mode or Schedule Mode. Tour Mode will cycle through tasks on a 

fixed interval. Schedule Mode will switch tasks at a pre-defined time of the day.

Enter project name
Select project type

Select task
Enter interval or start time 

Click Add

6. Under Task Name, select the task you would like to add to the project.

• If you selected Tour Mode, enter the Interval Time in minutes that the task will run for before 
changing to the next task.

• If you selected Schedule Mode, enter the time of day when the task will start running.

7. Click Add.
8. Repeat steps 6-7 for each additional task you would like to add to the project.
9. Click OK. Click OK to save changes.

Running Tasks and Projects

• Once you have configured tasks or projects, you may run them by clicking Task ( ) and 
then selecting the task or project you would like to run. 

• You may also select a task or project to run when you first launch the CMS. For details, see 
“Configuring CMS Options” on page 51.
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Using E-Map
The E-Map feature allows you to visually map your cameras over a .jpg image.

Configuring E-Map
Use the steps below to select a .jpg image to use for the E-Map and place your cameras.

To configure the E-Map:
1. Click Config Manager>E-Map Config.
2. Click Picture Edit.

Click Picture Edit

3. Click Add.

Click Add

4. Click Browse. Select a .jpg image on your computer to use as the E-Map.
5. Enter a Name and Title for your E-Map of your choice.

Click Browse to 
select a .jpg image

6. Click OK.
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7. Click Pic.

Click Pic

Home

Click and drag 
picture to the window

8. Click-and-drag the picture to the window to use it for the E-Map.
9. Click Device to view a list of connected s and IP cameras.
10. Click + next to an  or IP camera. To place cameras, drag cameras from the list to the map.

Click Device

Click +

Drag cameras to 
the map

11. Click Save.

NOTE: To delete all E-Map data, including images and camera positions, click Clear E-Map.

Opening Cameras from E-Map
Once you have configured your E-Map, you can use it to open cameras in live display.

To open cameras from E-Map:

1. Click E-Map ( ).
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2. Click on a display area in the main CMS window, then double-click on the camera to open it.

Click a display area

Double-click on a 
camera to open

Configuring the CMS
You can configure settings for the CMS such as the admin password, recording directories, and 
start up settings through the Config menu.

Configuring CMS Options

1. Click Config( )>Options.
2. Configure the following:

• Verify password: Check to require passwords when logging into or closing the CMS.

• Log in all devices: Check to allow the CMS to log into all s and IP cameras when it opens.

• Auto start record plan: Check to have the CMS automatically start the record plan, which 
allows recording to the computer hard drive when it opens. To configure the record plan, click 
Config Manager>Record Plan Config.
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• Auto Login FLIR SyncroIP  CMS: Check for the CMS to automatically log in the admin account 
when it is opened.

• Hotkey Setup: Configure hotkeys for the CMS. Use the drop-down menu to select the command, 
and then click inside the box on the right and enter the hotkey. 

NOTE: Do not use F12 as a hotkey. F12 is reserved for the system debug command.

• Displayed items in the right bar: Select which right-side menu is opened when the CMS opens.

• Record Time (M): Select the length in minutes of video files recorded on your computer hard 
drive. For example, if you select 15 minutes, the system will save a new video file for every 15 
minutes of recording.

• Snapshot picture path: Click ... to select the default save folder for snapshots.

• Picture file name rule: Click ... to define the file name rule for snapshots.

• Recorded file path: Click ... to select the default save folder for manual recordings.

• Recorded file name rule: Click ... to select the file name rule for manual recordings.

• Downloaded file path: Click ... to select the folder for downloaded recording files.

• Download record file name rule: Click ... to define the file name rule for downloaded recording 
files.

• Device free minimum space (MB): Enter the amount of minimum space in MB to maintain on 
the computer hard drive. The system will stop recording when only this much space is left.

• Auto Start Project: Check for the CMS to automatically run a project when opened. Select the 
project it will run under Project Name.

• Auto Start Task: Check for the CMS to automatically run a task when opened. Select the task 
it will run under Task Name.

• Last Run: Check for the CMS to start the last used task or project when opened.

• Save last monitor status: Check to have the CMS restore the previously used display mode 
when opened.

• Auto sync PC time to device: Check to have the s and IP cameras sync the clock with the 
system time on the PC.

• Sync time becomes valid at: Select the time that s or IP cameras will sync their clocks with 
the PC’s system time.

• Week: Select days that s or IP cameras will sync their clocks with the PC’s system time.

• Auto reboot device: Check to enable s or IP cameras to reboot when the time sync occurs.

3. Click Ok to save changes. Close the CMS and restart it to update the configuration.

Changing the CMS Admin Password
You can change the admin password that is used to log into the CMS. The default password is 
admin.

NOTE: The CMS will automatically populate the admin password unless you enable Verify 
Password under Config>Options.
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To change the CMS admin password:

1. When logged in as the admin account, click Config( )>Modify Password.
2. Under Old Password, enter the old password.
3. Under New Password and Confirm Password, enter the new password.

Enter old password

Enter new password

4. Click OK.

Adding User Accounts to the CMS
You can create multiple user accounts for the CMS with varying levels of access to the system. 
These user accounts are only used for access to the CMS software and are separate from the 
passwords on the  or IP camera systems.

NOTE: To make sure users must enter their user name and password to access the CMS, you 
must make sure Verify User is checked and Auto Login is unchecked in Config>Options. For 
details, see “Configuring CMS Options” on page 51.

To add a user account to the CMS:
1. Click Config Manager>User Manage.
2. Click Add.

Click Add

3. Configure the following:

• User: Enter the user name for the account.

• Password/Confirm: Enter the password for the account.

• Name/Sex/Information: (Optional) Enter descriptive details about the user account.

• Right: Check the permissions that will apply to the user account.

4. Click Save. Click OK to save changes.
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Multi-Monitor Support
The CMS supports up to 4 monitors on a single system. The recommended system specifications 
are listed below. If your system does not meet the requirements below, you may experience slow 
system performance.

Minimum system recommendations to run the CMS on multiple monitors:

• Intel Core i5 or i7 processor.

• 6 GB of RAM.

• Geforce 9500GT video card, 1GB or greater.

Opening Cameras in Secondary Monitors
• To open a single channel on a secondary monitor: Open it in a window on the main screen, 

then right-click on the display area, and select Output current window to extension screen. 
Select the monitor you would like to send the channel to.

• To open multiple-channels on a secondary monitor: Open your desired channel view, then 
right click in the display area, and select Output all windows to extension screen. Select the 
monitor you would like to send them to.

Managing Secondary Monitors
Use Ext Monitor Config to configure settings for secondary monitors. You can select which 
monitors you would like to enable. Enabled monitors start up when you open the CMS software.

You can close secondary monitors by clicking on them and then pressing ESC. However, you must 
close the CMS software and restart it to re-open windows on secondary monitors.

To manage secondary monitors:
1. Click Config Manager>Ext Screen Manager.

Right-click and select output option to open 
channels on a secondary monitor
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2. Click Search to detect secondary monitors or Identify to display the monitor number 
assigned to each secondary monitor.

Click to detect monitors

Click to show monitor 
number on screen

3. Check monitors to open them when the CMS software opens or uncheck to disable.

Check monitors to have them 
open when the CMS opens

4. Click OK to save changes. Restart the CMS software to open the new monitor configuration.
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SMARTPHONE AND TABLET APPS

iPhone
FLIR SyncroIP NVR is an iPhone app that allows you to remotely view your IP camera.

System Requirements
• iOS 4.3 or later.

Prerequisites
• Port 80 and 35000 (or your HTTP and Client Ports, if you have changed them) must be port 

forwarded on your router to your camera’s IP address.

• You must create a DDNS account, and have the DDNS settings configured in your IP camera.

• The IP camera must have Internet access.

• You must have a DDNS address to log in remotely.

• An iTunes account.

NOTE: You will need to create an iTunes account before you can download the app. An iTunes 
store account requires a valid credit card number. The app is free of charge.

Connecting to your IP camera on an iPhone
1. Download FLIR SyncroIP NVR for free from the App Store.

2. Tap on the FLIR SyncroIP NVR icon ( ) to start the app.

3. Tap .
4. Tap Device Manager.

Device Manager
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Smartphone and Tablet Apps
5. Tap Add>Manually Add.

Tap Add

6. Configure the following:

Enter a name for 
your 

Enter the DDNS 
address

Enter the Client Port

Enter the user name

Enter the password

Enter 1

tomsmith.myddns-flir.com

1

• Name: Enter a name for your IP 
camera of your choice.

• Address: Enter your DDNS 
address (e.g. 
tomsmith.myddns-flir.com).

• Port: Enter the Client Port 
(default: 35000).

• Username: Enter the IP 
camera’s User Name (default: 
admin).

• Password: Enter the IP 
camera’s Password (default: 
admin).

• Channel: Enter 1.

7. Tap Save.

8. Tap .
9. Tap Live Preview.
10. Tap + on one of the display areas and select the camera to open it in the selected display area. 

Tap + and select the camera
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FLIR SyncroIP NVR Interface
You can use FLIR SyncroIP NVR in portrait and landscape mode.

Viewing Videos with Local File
If you have saved videos using FLIR SyncroIP, you may open them with Local File.

NOTE: You may open screenshots using the Photos app.

To access Local File:

• From the Main Menu, tap Local File.

Double-tap to open a 
channel in full-screen

Connect to camera

Disconnect from camera

Connect to all previously added 
cameras

PTZ

Disconnect all

Access Favorites

Change Camera

Snapshot

Start/stop manual 
record

Open image settings

Return to Main Menu

Tap files to open

Delete all filesReturn to Main Menu
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Smartphone and Tablet Apps
Using Playback Mode on iPhone
You can access recorded video on your IP camera’s microSD card using your iPhone.

NOTE: You must configure your camera to record the sub stream to use playback mode on 
mobile devices. For details, see “Record Control” on page 28.

To use Playback Mode:
1. From the Main Menu, tap Playback.

NOTE: If Playback is not shown, tap Add, check Playback, and return to the Main Menu.

2. Tap +.

Tap + 

3. Select the start and end times to playback. 
4. Select a camera to playback.

Select start time 

Select end time 

Select channel
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5. Use the on-screen controls to control playback.

Double-tap to open in 
full-screen

Select previous video file

Select next video file

Play/pause

Next frame

Fast

Slow

Enabling Push Notifications
You can have the app send push notifications to the notifications area on your device when the 
camera detects motion. Once you have received a push notification, you can select it to open live 
video from the camera.

NOTE: Motion detection must be activated to receive push notifications. For details on enabling 
motion detection, see “Video Detect” on page 19.

NOTE: Your camera must be configured to record the sub-stream to open video from push 
notifications. For details on configuring sub-stream recording, see “Record Control” on page 28.

To enable Push Notifications:
1. From the Main menu, tap Push Config.

NOTE: If Push Config is not shown, tap Add, check Push Config, and then return to the Main 
Menu.

2. For the IP camera you would like to configure, set the slider to ON.

Set to ON

Push notification
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Smartphone and Tablet Apps
3. Tap Motion Detect and then check CAM 1.

Check channels to enble 
push notifications

4. Tap OK. A test notification will be sent to your device. After this, whenever the selected 
cameras detect motion, you will receive a notification. 

Device Manager
You can use Device List to manage your IP cameras and NVRs.

To access Device List:

• From the Main Menu, tap Device Manager.

To edit a device: 
1. Tap the device in Device Manager.
2. Edit the connection details as needed.
3. Tap Save.
To delete a device:
1. Swipe right on the device you would like to delete.

Swipe right on the device you would like 
to delete and tap delete

2. Tap Delete. Tap OK to confirm.
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Smartphone and Tablet Apps
iPad
FLIR SyncroIP NVR HD is an iPad app that allows you to remotely view your IP camera.

System Requirements
• iOS 4.3 or later.

Prerequisites
• Port 80 and 35000 (or your HTTP and Client Ports, if you have changed them) must be port 

forwarded on your router to your camera’s IP address.

• You must create a DDNS account, and have the DDNS settings configured in your IP camera.

• The IP camera must have Internet access.

• You must have a DDNS address to log in remotely.

• You will need to create an iTunes account before you can download the app. An iTunes store 
account requires a valid credit card number. The app is free of charge.

Connecting to your IP camera on an iPad
1. Install FLIR SyncroIP NVR HD for free from the App Store.

2. Tap on the FLIR SyncroIP NVR HD icon ( ) to start the app.

3. Tap  then .
4. Tap Device Manager.

Tap Add

5. Tap Add.
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6. Configure the following:

Enter a name for your IP camera

Enter the DDNS address

Enter the Client Port

Enter the user name

Enter the password

Enter 1

tomsmith.myddns-flir.com 

1

• Name: Enter a name for your IP camera of your choice.

• Address: Enter your DDNS address (e.g. tomsmith.myddns-flir.com).

• Port: Enter the Client Port (default: 35000).

• Username: Enter the IP camera’s User Name (default: admin).

• Password: Enter the IP camera’s Password (default: admin).

• Channel amount: Enter 1.

7. Tap Save.

8. Tap .
9. In landscape mode: tap a channel and then select the camera you would like to view on the 

left. 
OR 
In portrait mode: tap + on one of the display areas and select the camera you would like to 
open.

Click + and then 
select a camera
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Smartphone and Tablet Apps
FLIR SyncroIP NVR HD Interface
You can use FLIR SyncroIP NVR HD in landscape or portrait mode.

Device Manager
Device Manager allows you to manage your IP cameras and NVRs.

To access Device Manager:

1. From live view, tap  then .
2. Tap Device Manager.
To delete a device:
1. Tap the device to select it.

2. Tap . Tap Yes to confirm.

Tap to delete

To modify a device:
1. Tap a device to select.
2. Tap the device again to open the edit screen.
3. Update the connection details as needed and then tap Save.

Double-tap to open 
in full screen

Disconnect all
Add current 
view to favorites

Snapshot
Change 
display view

Slide to select favorites

Select different camera

Open menus
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Smartphone and Tablet Apps
Using Playback Mode on iPad
You can access recorded video on your IP camera using your iPad.

NOTE: You must configure your camera to record the sub stream to use playback mode on 
mobile devices. For details, see “Record Control” on page 28.

To use Playback Mode:

1. From Live View tap  then .
2. In Portrait Mode: Tap +, select the start time and end time for your search, and select the 

camera you would like to playback.
OR
In Landscape Mode: Select the start time and end time for your search, and select the 
camera you would like to playback.

Select start time
Select end time

Select camera

3. Use the playback controls.

Pause/play

Previous file Next file

NOTE: Playback controls are only shown in portrait mode.
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Smartphone and Tablet Apps
Enabling Push Notifications
You can have the app send push notifications to the notifications area on your device when the 
camera detects motion. Once you have received a push notification, you can select it to open live 
video from the camera that detected motion.

NOTE: Motion detection must be activated to receive push notifications. For details on enabling 
motion detection, see “Video Detect” on page 19.

NOTE: Your camera must be configured to record the sub-stream to open video from push 
notifications. For details on configuring sub-stream recording, see “Record Control” on page 28.

To enable Push Notifications:

1. From live view, tap  then .
2. Tap Alarm Push.
3. Set the slider to ON next to the IP camera you would like to configure.

Set to ON

4. Tap Motion Detect then check CAM 1.

Check CAM 1

Push notification
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5. Tap OK. A test notification will be sent to your device. After this, whenever the selected 
cameras detect motion, you will receive a notification.

NOTE: You can see a list of notifications through the Event List menu. To show the Event List 

menu, from live view, tap  then .

Tap on an event to view live video 
from the camera

Android Phones
FLIR SyncroIP NVR allows you to remotely view your IP camera on Android smartphones.

A separate app is available to remotely view your IP camera on Android tablets, to make better 
use of the larger screen size. For details, see “Android Tablets” on page 73.

Compatible Devices
• Android OS (2.2 and above).

Prerequisites
• Port 80 and 35000 (or your HTTP and Client Ports, if you have changed them) must be port 

forwarded on your router to your camera’s IP address.
• You must create a DDNS account, and have the DDNS settings configured in your IP camera.
• The IP camera must have Internet access.
• You must have a DDNS address to log in remotely.

Connecting to your IP Camera on an Android Phone
1. Download FLIR SyncroIP NVR for free from the Google Play Store.

2. Tap on the FLIR SyncroIP NVR icon ( ) to start the app.

3. Tap .
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4. Tap Device Manager.

Device Manager

5. Tap Add>Manually Add.

Tap Add

6. Configure the following:

Enter a name for 
your IP camera

Enter the DDNS 
address

Enter the Client Port

Enter the user name

Enter the password

Enter 1

tomsmith.myddns-flir.com 

1

• Name: Enter a name for your IP 
camera of your choice.

• Address: Enter your DDNS 
address (e.g. 
tomsmith.myddns-flir.com).

• Port: Enter the Client Port 
(default: 35000).

• Username: Enter the IP 
camera’s User Name (default: 
admin).

• Password: Enter the IP 
camera’s Password (default: 
admin).

• Channel: Enter 1.

7. Tap Save.

8. Tap .
9. Tap Live Preview.
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10. Tap + on one of the display areas and select the camera you would like to open in the selected 
display area. 

Tap + and select a camera

11. Repeat to view additional cameras.

FLIR SyncroIP NVR Interface
You can use FLIR SyncroIP NVR in portrait and landscape mode.

Double-tap to open a 
channel in full-screen

Connect to camera

Disconnect from camera

Connect to all previously added 
cameras

PTZ

Disconnect all

Access Favorites

Change Camera

Snapshot

Start/stop manual 
record

Open image settings

Return to Main Menu
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Smartphone and Tablet Apps
Viewing Snapshots and Videos with Local Files
If you have saved snapshots or videos using FLIR SyncroIP NVR, you may open them with Local 
Files.

To access Local Files:

• From the Main Menu, tap Local Files.

Using Playback Mode on Android Phones
You can access recorded video on your IP camera using your Android phone.

NOTE: You must configure your camera to record the sub stream to use playback mode on 
mobile devices. For details, see “Record Control” on page 28.

To use Playback Mode:
1. From the Main Menu, tap Playback.
2. If Playback is not shown, tap Add, check Playback, and return to the Main Menu.

Tap files to open

Open snapshots Open videos

Delete all filesReturn to Main Menu
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Smartphone and Tablet Apps
3. Tap + and select a camera to playback.

Tap + and select a 
channel to playback

4. Select the date then the start and end times to playback.
5. Use the on-screen controls to control playback.

Double-tap to open in 
full-screen

Select previous video file

Select next video file

Play/pause

Next frame

Fast

Slow

Enabling Push Notifications
You can have the app send push notifications to the notifications area on your device when one of 
your cameras detects motion. Once you have received a push notification, you can select it to open 
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live video from the camera that detected motion.

NOTE: Motion detection must be activated to receive push notifications. For details on enabling 
motion detection, see “Video Detect” on page 19.

NOTE: Your camera must be configured to record the sub-stream to open video from push 
notifications. For details on configuring sub-stream recording, see “Record Control” on page 28.

To enable Push Notifications:
1. From the Main menu, tap Push Config.

NOTE: If Push Config is not shown, tap Add, check Push Config, and then return to the Main 
Menu.

2. Tap the IP camera you would like to configure.

Select the IP camera

3. Tap Motion Detect and then check CAM 1.

Check CAM 1

4. Tap OK. A test notification will be sent to your device. After this, whenever the selected 
cameras detect motion, you will receive a notification. 

Push notification

NOTE: Appearance of notifications may differ
depending on the model of your device
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Device Manager
You can use Device List to manage your IP cameras and NVRs.

To access Device List:

• From the Main Menu, tap Device Manager.

To edit a device:
1. Tap the device in Device Manager.
2. Edit the connection details as needed.
3. Tap Save.
To delete a device:
1. Swipe the device you would like to delete to the right.
2. Tap Delete. Tap OK to confirm.

Tap Delete

Android Tablets
FLIR SyncroIP NVR HD is an app that allows you to remotely view your IP camera on an Android 
tablet.

System Requirements
• Android 3.3 or later.

Prerequisites
• Port 80 and 35000 (or your HTTP and Client Ports, if you have changed them) must be port 

forwarded on your router to your camera’s IP address.
• You must create a DDNS account, and have the DDNS settings configured in your IP camera.
• The IP camera must have Internet access.

• You must have a DDNS address to log in remotely.

Connecting to your IP Camera on an Android Tablet
1. Install FLIR SyncroIP NVR HD for free from the Google Play Store.

2. Tap on the FLIR SyncroIP NVR HD icon ( ) to start the app.

3. Tap  then .
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Smartphone and Tablet Apps
4. Tap Device Manager.

Tap Add

5. Tap Add.
6. Configure the following:

Enter a name for your IP camera

Enter the DDNS address

Enter the Client Port

Enter the user name

Enter the password

Enter 1

tomsmith.myddns-flir.com 

1

• Name: Enter a name for your IP camera of your choice.

• Address: Enter your DDNS address (e.g. tomsmith.myddns-flir.com).

• Port: Enter the Client Port (default: 35000).

• Username: Enter the IP camera’s User Name (default: admin).

• Password: Enter the IP camera’s Password (default: admin).

• Channel amount: Enter 1.

7. Tap Save.

8. Tap .
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9. In landscape mode, tap a display area and then select the camera you would like to view on 
the left. In portrait mode, tap + on one of the display areas and select the camera you would 
like to open.

Click + and then 
select a camera

FLIR SyncroIP NVR HD Interface
You can use FLIR SyncroIP NVR HD in landscape or portrait mode.

Double-tap to open 
in full screen

Disconnect selected 
channel

Add current 
view to favorites

Snapshot
Change 
display view

Slide to select favorites

Select different camera

Open configuration menu
75



Smartphone and Tablet Apps
Using Playback Mode on Android Tablets
You can access recorded video on your IP camera using your Android tablet.

NOTE: You must configure your camera to record the sub stream to use playback mode on 
mobile devices. For details, see “Record Control” on page 28.

To use Playback Mode:

1. From Live View tap  then .
2. In Portrait Mode: Tap +, select the start time and end time for your search, and select the 

camera you would like to playback.
OR
In Landscape Mode: Select the start time and end time for your search, and select the 
camera you would like to playback.

Select start time

Select end time

Select camera

3. Use the playback controls.

Pause/play

Previous file Next file

NOTE: Playback controls are only shown in portrait mode.
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Enabling Push Notifications
You can have the app send push notifications to the notifications area on your device when the 
camera detects motion. Once you have received a push notification, you can select it to open live 
video from the camera.

NOTE: Motion detection must be activated to receive push notifications. For details on enabling 
motion detection, see “Video Detect” on page 19.

NOTE: Your camera must be configured to record the sub-stream to open video from push 
notifications. For details on configuring sub-stream recording, see “Record Control” on page 28.

To enable Push Notifications:

1. From live view, tap  then .
2. Tap Alarm Push.
3. Select the IP camera you would like to configure.

Select the IP camera you 
would like to configure

Push notification

NOTE: Appearance of notifications may differ 
depending on the model of your device
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Smartphone and Tablet Apps
4. Tap MotionDetect then check CAM 1.

Check CAM 1

5. Tap OK. A test notification will be sent to your device. After this, whenever the selected 
cameras detect motion, you will receive a notification.

NOTE: You can see a list of notifications through the Event List menu. To show the Event List 

menu, from live view, tap  then .

Tap on an event to view live 
video from the camera

Device Manager
Device Manager allows you to manage your IP cameras and NVRs.

To access Device Manager: 

1. From live view, tap  then .
2. Tap Device Manager.
To delete a device:
1. Tap the device to select it.
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2. Tap . Tap OK to confirm.

Tap to delete

To modify a device:
1. Tap a device to select.
2. Tap the device again to open the edit screen.
3. Update the connection details as needed and then tap Save.
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We welcome your feedback at 
info@digimerge.com

For more information, visit 
www.digimerge.com
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3 Easy Ways To Contact Us

Please make sure to visit our website www.digimerge.com
to receive product updates and information.

North America:  1-866-816-5919

Technical  support (for technical / instal lation issues) 

Mon-Fri  8.00 am to 8.00pm EST

By Phone:

Product support is  available 24/7 including product 

information, user manuals,  quick start up guides and FAQ’s 

at www.digimerge.com

Online:

Technical  support (for technical / instal lation issues)

tech@digimerge.com

By Email:

Need Help?
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